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IMPORTANT SAFETY
INSTRUCTIONS
For the safe handling of the Q-matic System,
observe the safety instructions in the following
manuals:

• Assembly instruction Quilt Frame

• Assembly instruction Q-matic

• Instruction manual BERNINA Q Series
Machine

WARRANTY AND
LIABILITY REGULATIONS
for software
No part of this publication or the accom-
panying software may be copied or distributed,
transmitted, transcribed, saved in a database,
translated into a human or computer language
or made accessible to third parties in any
format or in any manner, whether electron-
ically, mechanically, magnetically, manually or
in any other way.

NOTE

The screen illustrations from the software in
this guide are intended to be representations
and may differ from those in the actual
software delivered.

PRINTED USER GUIDE

Registered users of BERNINA Q-matic software
are permitted to create one (1) copy of the
BERNINA Q-matic instruction manual for
personal use. This can be printed using a
private printer or a commercial printing office.

LIMITED WARRANTY

BERNINA International AG warrants for a
period of 90 days, commencing from the date
of handover of the software to you, that the
product is free from defects in materials and
workmanship. You have the option, during the
warranty period only, to return the products
covered by this warranty, together with proof

of purchase for the former, to BERNINA or an
authorized BERNINA specialist. You receive a
replacement free of charge. You pay for any
shipping and insurance costs. You alone bear
the risk of any loss, damage or for losing
products. The purchaser relies on their
knowledge and judgment in selecting the
software for their own use and assumes the
entire risk as to the results and performance of
the software. Subject to warranties and
conditions determined by law, BERNINA Inter-
national AG expressly refuses to recognize any
other warranties and conditions, whether
these are expressed or implied, including
without limitation, warranties and conditions
of merchantability, fitness for a particular
purpose, property rights and infringement of
third-party rights. BERNINA International AG
does not guarantee that the software meets
the purchaser's requirements, runs without any
interruptions or errors or appears as shown in
the accompanying documentation.

LIMITED LIABILITY

Where legally permissible, under no circum-
stances will BERNINA International AG or its
developers, officers, employees or subsidiaries
be liable to you for any consequential,
incidental or indirect damages (including
damages for loss of business profits, business
interruption, loss of business information and
the like), whether foreseeable or unfore-
seeable, arising out of the use of or inability to
use the software or the control cabinet and
cable supplied, as well as the instruction
manual, regardless of the basis of the claim
and even if BERNINA or an authorized
BERNINA representative has been advised of
the possibility of such damages. Some states or
jurisdictions do not allow the exclusion of
incidental, consequential or special damages,
so the above limitations of liability may not
apply to you.

TERMINATION

Your license to use the BERNINA Q-matic
software is effective as long as you comply
with the terms and conditions of the License
Agreement. If you fail to comply with the
terms and conditions of the License
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Agreement, this license shall automatically be
terminated immediately and without notice by
BERNINA International AG. You may terminate
this license at any time by returning the
BERNINA Q-matic software and all copies
thereof, the control cabinet and cables, as well
as all accompanying documentation, to
BERNINA International AG.

Use of antivirus software and other programs:

As a general rule, no programs other than the
software already installed upon delivery should
be installed on the supplied Q-matic PC. The
Internet should only be accessed if this is
expressly demanded by BERNINA or Art &
Stitch customer service/support in connection
with technical support. In addition, specifically,
no antivirus software should be used other
than the «Windows Defender» program
already installed under Windows 10. Only if
these measures are followed will the Q-matic
system work without any problems. For this
reason, always use your personal laptop or PC
to surf the Internet in order to purchase
designs or run other software.

License agreements for Q-matic software and Art &
Stitch software

The license agreements for the Q-matic
software and Art & Stitch software are
automatically accepted by the owner/user
when the software is installed and used.
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1 Important Information

Availability of the Instruction Manual

The manual forms part of the system.

• Store the manuals of the system components in a suitable location near the product and keep them
available to consult.

• If the product is passed on to third parties, always include the manuals with the product.

Proper Use

The BERNINA Q-matic automation system is conceived and designed for private household use. It is used for
the automated quilting of designs that you create yourself using machines of the BERNINA Q series on the
quilting frame. Any other use is not considered proper. BERNINA assumes no liability concerning
consequences resulting from an improper use.

Explanation of Symbols

 DANGER Designates a danger with a high risk which can lead to serious injuries or even death unless it is avoided.

 WARNING Designates a medium-risk hazard which can lead to serious injuries if not avoided.

 CAUTION Designates a low-risk hazard which can lead to minor or moderate injuries if not avoided.

NOTICE Designates a hazard which can lead to material damage if not avoided.

Tips from the BERNINA quilting experts.

1.1 Internet Usage with the Q-matic PC

The standard Microsoft antivirus program is installed on the Q-matic PC. Viruses could nevertheless infiltrate
and cause harm.

> To ensure that the Q-matic system works without interference, do not install any other antivirus
software.

Access to the Internet is only permitted with the Q-matic PC for Windows updates and when requested by
BERNINA Customer Service or Art & Stitch.

> To buy other designs on the Internet, use another computer.
> To use software other than Q-matic or Art & Stitch, use another computer.
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2 My Q-matic system

2.1 Introduction

Large quilting projects can be created with the Q Series machines. The Q-matic automation system supports
creative designing of quilt layouts and automatic sewing out of designs on the quilt.

The Q-matic automation system comprises:

• Q-matic hardware: Mechanical and electronic parts, for automated machine movements on the frame.
• Q-matic PC with touchscreen: To operate the software.
• Q-matic software: For designing whole quilt tops, editing individual designs and controlling the Q-matic

hardware during automatic sewing out of the quilt design.

Further Information

The following information products are included with your BERNINA Q-matic:

• Assembly Instructions for the Q-matic System
• Instruction Manual for the Q-matic Software

The machine's instruction manual contains further important information regarding work with the Q-matic
system.

The current version of the assembly instructions, the instruction manual, a video of the assembly instructions
and a great deal of further information about the machine and the accessories can be found on our
website .

2.2 Welcome to the World of BERNINA

Made to create, this is the slogan of BERNINA. Not only with our machines do we support you in the
implementation of your ideas. In addition to the offers listed below, we offer you lots of suggestions and
instructions for your future projects as well as the opportunity to exchange ideas with other sewing, quilting
and embroidery enthusiasts. We wish you lots of pleasure.

BERNINA YouTube Channel

On YouTube we offer a wide range of how-to videos and support concerning the most important functions
of our machines. You can also find detailed explanations of presser feet and accessories that make your
projects successful.

youtube.com/BerninaInternational

Available in English and German.

"inspiration" – the Creative Sewing Magazine and Online Store with Sewing Patterns

Are you looking for ideas, sewing patterns and instructions for great sewing projects? If so, the BERNINA
magazine “inspiration” is just the right thing for you. Three times a year, “inspiration” offers you great
sewing and embroidery ideas. From seasonal fashion trends to trendy accessories and practical tips to
original decorations for your home or cute sewing ideas for children.

The magazine is available in English, German, Dutch, and French.

In our online shop you can purchase "inspiration" as an e-magazine or as a print version, either as individual
issues or as a subscription. Furthermore, there are many individual downloadable patterns to discover! Why
not take a look at:

inspiration.bernina.com

And follow us on Instagram (@inspiration.sewing.magazine).

https://www.youtube.com/BerninaInternational
https://inspiration.bernina.com
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BERNINA Blog

Sophisticated instructions, free sewing patterns and embroidery designs as well as many new ideas can be
found weekly on our BERNINA Blog. Our experts give useful tips and step by step instructions to achieve your
desired results. In the community you can upload your own projects and exchange experiences and ideas
with other sewing and embroidering enthusiasts.

bernina.com/blog

Available in English, German, Dutch and French.

BERNINA Social Media

Follow on social networks to learn more about events, exciting projects and tips and tricks all about sewing,
quilting and embroidering. We will keep you informed and are looking forward to sharing highlights from
the world of BERNINA.

bernina.com/social-media

BERNINA World App

Download the BERNINA App to your smartphone and enjoy direct access to all product information. The
accessory organizer gives you an overview of your accessories and those you would like to have.
Furthermore, you have direct access to the customer portal, the blog and the "inspiration" online store, and
you can always find a BERNINA dealer near you. The app is available in the Apple App Store and the Google
Play Store.

bernina.com/app

https://www.bernina.com/blog
https://www.bernina.com/social-media
https://www.bernina.com/app
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3 My Q-matic Software

3.1 Installation

The Q-matic software and Art & Stitch software are installed during start up of the system. If the Q-matic
software is not installed when the Q-matic PC is first started, it can be installed according to the section on
«Installing software»  (see page 58). More information on starting up can be found in the assembly
instructions.

For more significant adaptations of designs, we recommend additionally installing «Art & Stitch» on a
separate PC. The second Art & Stitch license that was supplied can be used for this.

3.2 Overview of Q-matic – Art & Stitch

The system consists of various mechanical components, electronics, the Q-matic PC, and the Q-matic and
Art & Stitch software programs.

Q-matic Software

A quilting project can be easily and intuitively designed with the Q-matic software. The Q-matic software
contains more than 325 designs, which can be edited through simple commands and placed on the quilt
top. The finished quilting project can be automatically sewn.

Art & Stitch Software

Art & Stitch is an comprehensive digitization program with which you can create your own designs.
Art & Stitch has more than 350 designs that can be freely used or edited. Use Art & Stitch to open files and
designs of different longarm file formats and vector graphics, digitize a design from a picture, design an
appliqué design or create creative filler designs as a background. In addition, existing designs can be altered
at your discretion, saved in any major longarm file format and directly imported into the Q-matic software.

Further information and instruction manuals can be found at https://artandstitch.com or directly in the
program under the «Help» function.

Exchanging Designs between Q-matic and Art & Stitch

Designs can easily be exchanged between Q-matic and Art & Stitch. A design can be transferred to
Art & Stitch, edited there in detail, and also easily transferred back to Q-matic. The design must be saved
in .ans format before transfer. Then it can be reimported at any time.

https://www.artandstitch.com/
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3.3 Overview of User Interface

1

2

3

4

5

6

1 Menu Bar 4 Control Area

2 Quilt Design Area 5 Tool Center

3 Speed Control 6 Design Center

3.4 Overview Menu Bar

The menu bar contains menus with the functions. Some functions are also available in the «Tool Center».
The corresponding icons can be found in the overview table.

Menu Function Icon Purpose

«File» «Open Project» Open a project.

«New Project» Create a new project.

«Save»

• «Save Design File»
• «Save Project»

Saving

• Save a design.
• Save a project.

«Delete»

• «Delete Design File»
• «Delete Project»

Deleting

• Delete a design.
• Delete a project.

«Edit» «Delete a design» Delete design.

«Copy a design» Copy design.

«Undo» Undo an action.

«Redo» Redo an action.
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Menu Function Icon Purpose

«View» «Normal View» Standard display. The center of the view can be established
with zoom functions or the scroll bar.

«Needle Center» The needle position always remains in the center of the view.

«Center Zoom» Enlarge and center a section.

«Actual Size» 1 1 Show the actual size of a section.

«Full View» Show the entire quilt.

«Zoom In» Enlarge a section.

«Zoom Out» Reduce a section.

«Tools» «Safe Area» Determine quiltable area.

«Select» Select a design.

«Quilt Size» Specify quilt size.

«Design Pool» Select designs for "Design Center".

«Markers» Set markers.

«Realign Safe Area» Adjust the quiltable area.

«Grab/Drop» Grab the design with the needle and drop it with the machine.

«Reverse Sew» Change sewing direction.

«Sew Options» 2
1

3
Change sewing settings.
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Menu Function Icon Purpose

«Design Tools» «Resize» Alter the design size.

«Flip» Mirror design horizontally.

«Mirror» Mirror design vertically.

«Rotate» Rotate design.

«Trim» Trim the design.

«Mask» Mask the design.

«Boundary» Set the boundary lines.

«Align» Align designs.

«Connect» Connect designs.

«Unconnect» Unconnect designs.

«E2E More» Add pantograph design.

«E2E Less» Remove pantograph design.

«Multiply» Multiply designs.

«Settings» «Pause to pull bobbin» Interrupt sewing to activate/deactivate lifting of the bobbin
thread.

«Sewing» Activate/deactivate sewing.

«Show jump stitches» Show/hide jump stitches.

«Sound» Switch sounds on/off.

«Easy Glide» Activate/deactivate «Easy Glide»function.

«MicroMove» Activate/deactivate «MicroMove»function.

«Easy Glide Settings» Set resistance for Easy Glide.
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Menu Function Icon Purpose

«Design Library» «Import Design» Import a design.

«Manage Tags» Manage tags.

«Design Tags» Assign/remove tags.

«?» «How-To Videos» Show how-to videos.

«Contact Us» Show contact details.

«About» Show software versions.

3.5 Overview of Quilt Design Area

1

2 3

4 5 6 7

8 9 10 11 12 13

1 Quilt Design Area 8 «MicroMove»

2 «Width:» Width of the Design 9 «Sewing»

3 «Height:» Height of the Design 10 «Start»

4 «Safe Area», quiltable space 11 «Pause»

5 «Easy Glide» 12 «Stop»

6 «Pause to pull bobbin» 13 «Nudge»

7 «Art & Stitch»



MY Q-MATIC SOFTWARE

15

3.6 Overview of Tool Center

Illustration Name Purpose

«Select» Select a design.

«Design Pool» Select designs for "Design Center".

«Copy»

«Delete»

Copy design.

Delete design.

«Center Zoom» Enlarge and center a section.

1 1 «Actual Size»

«Full View»

Show the actual size of a section.

Show the entire quilt.

«Zoom In»

«Zoom Out»

Enlarge a section.

Reduce a section.

«Quilt Size» Enter quilt size.

«Markers» Set markers.

«Realign Safe Area» Adjust the quiltable area.

«Grab/Drop» Grab the design with the needle and drop it with
the machine.
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Illustration Name Purpose

2
1

3
«Sew Options» Change sewing settings.

«Reverse Sew» Change sewing direction.

«Rotate» Rotate design.

«Flip» Mirror design horizontally.

«Mirror» Mirror design vertically.

«Mask» Mask the design.

«Boundary» Set the boundary lines.

«Trim» Trim the design.

«Undo»

«Redo»

Undo an action.

Redo an action.

«E2E+»

«E2E-»

Add pantograph design.

Remove pantograph design.

«Multiply» Multiply designs.

«Connect»

«Unconnect»

Connect designs.

Unconnect designs.

«Align» Align designs.

«Resize» Alter the design size.

3.7 Software Operation

The Q-matic PC can be operated with your finger or with a touchscreen pen.

Activate and Deactivate Functions
> Tap the object to be edited in the «Quilt Design Area».
> Tap the desired function in the «Tool Center» or in the menu.
> Where applicable, implement settings and apply the function.
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Call Up Help

Illustration Name Purpose

?

«Help» Call up help.

Entering Numbers

A prompt for a value entry is displayed with the «Enter Number» window.

Illustration Name Purpose

C «Clear» Empty entry field.

« «Backspace» Delete last character.

OK «Confirm» Confirm the input and close the window.

CANCEL «Cancel» Discard input and close window.

Moving the Design

Illustration Name Purpose

«Nudge» Move the design in the «Quilt Design Area» pixel
by pixel.
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Confirming the Entry

Illustration Name Purpose

OK

«Confirm» Confirm the input and close the window.

Discarding the Entry

Illustration Name Purpose

CANCEL

«Cancel» Discard input and close window.

Preview

Illustration Name Purpose

Preview «Preview» Display settings in the preview.

CLR «Clear» Discard changes and close preview.

Closing the Window

Illustration Name Purpose

«Close» Close the window.

Unsaved changes are not applied.

Screen Gestures

Illustration Name Purpose

Tap Tap object.

Long Tap Press and hold object.

«Zoom Out» Reduce a section.

«Zoom In» Enlarge a section.

Pan Move the visible area of the «Quilt Design Area».
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4 Quilting Preparation

4.1 Preparing the Machine

Prepare the machine for quilting according to the instruction manual of the machine.

4.2 Starting Q-matic System

2

1

3

> To ensure that the emergency stop button is unlocked, rotate the button (1) in the direction of the
arrow.

> Switch on the control cabinet using the main switch (2).
> Press and hold the green start button (3) for three seconds until you hear a click.
> Switch on the Q-matic PC with its own on/off switch.

– The PC is starting.

> Open Q-matic software.
> If the machine is not yet switched on, switch on the machine. Refer to the instruction manual of the

machine.
– Q-matic is ready for operation.

4.3 Switching Off the Q-matic System

NOTICE Switching off the Q-matic system improperly
Q-matic PC Software Damage
> Always shut down the Q-Matic PC via the Windows process first.
> Finally, switch off the control cabinet using the main switch (2).

ð Premature switching off of the control cabinet can lead to damage to the Q-matic PC.

> Close the Q-matic software.
> Shut down the Q-Matic PC according to the PC Users Guide from DELL. In general, shut down the

Windows operating system.
> Switch off the control cabinet using the power switch.
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Emergency

 WARNING System Not Controllable
Risk of injury.
> Press the red emergency stop button.

Switching Off in an Emergency

Only press the emergency stop button in case of emergency!

> Press the red emergency stop button at the top of the control cabinet.

– The power supply is immediately interrupted.

Switching On after an Emergency
> Turn the red emergency stop button in the direction of the arrow.

– The emergency stop button is unlocked.

– The power supply is reactivated.

> Restart the system. (see page 19)
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4.4 Setting the Safe Area

The «Safe Area» defines the quiltable area, i.e. the area of the quilting project where the machine can sew.

The settings window for the «Safe Area» opens automatically each time the software is started. If necessary,
the «Safe Area» can be reset any time.

> Tap «Safe Area».

1

2

> Move the sewhead to the top left corner of the quiltable area.
> To confirm the top left corner, tap «Set» (1) or press any toggle switch.
> Move the sewhead to the bottom right corner of the quiltable area.
> To confirm the bottom right corner, tap «Set» (2) or press any toggle switch.

– The positions are applied and the window is closed.

– In the «Quilt Design Area», the «Safe Area» is marked with a red frame.

4.5 Entering the Quilt Size

The quilt size is displayed in the «Quilt Design Area» as a bold red frame. This allows the designs or
pantograph designs to be adjusted to the quilt size.

> Tap «Quilt Size».

> Enter and confirm the «Width» and «Height» in inches.
– A bold red frame appears in the «Quilt Design Area», which corresponds precisely to the size of the

quilt top.
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5 Creative Quilting

5.1 Selecting Designs for a Project

All imported designs can be found in the «Design Pool» of the Q-matic software. For a better overview, it is
recommended that you collect a preselection of the designs for the quilting project in the «Design Center».
Tags can be used to search. The designs can be put into the «Quilt Design Area» from the «Design Center»,
and sewn out on the quilt from there.

> Click «Design Pool».
> To copy a design from the «Design Pool» (2) into the «Design Center» (3), double-click the design.

– The design is copied into the «Design Center» (3).

– The design is highlighted in the «Design Pool» (2) in light gray.

Close > When all desired designs for the project have been selected, click «Close».

1 2 3

1 Search Area 3 «Design Center»

2 «Design Pool»

Operating Component Purpose

Search Area (1)

«Search» Input field for search term.

«Match any tag» Show designs that include one of the selected tags.

«Match all tags» Show designs that include all selected tags.

List of Tags List of all selectable tags.

«Design Pool» (2) Display of all designs.

«Design Center» (3) Display of the selected designs.

«Clear All» Remove all designs from the «Design Center».

«Close» Close «Design Pool».
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5.2 Placing Designs

Use the following functions to accurately place quilt designs on the quilt:

• Set markers («MARKERS»)
• Place design with sewhead («GRAB/DROP»)
• Set boundary («BOUNDARY»)
• Mask design («MASK»)
• Trim design («TRIM»)
• Align design («ALIGN»)
• Alter design size («RESIZE»)

For most of these functions, a design can be placed in the «Quilt Design Area» of the software or with the
sewhead («Sewhead»). When placing the design with the sewhead, the design is connected to the needle.
The sewhead is moved by hand to the desired start point. With the «MicroMove» function, the sewhead can
be moved in small steps until the needle is precisely in the desired position. With the touch of a button, the
needle position is transferred to the software.

MicroMove

With «MicroMove», lines and points in the «Quilt Design Area» can be set exactly by moving the needle over
the quilt in microsteps. The position of the needle is transferred to the «Quilt Design Area» at the touch of a
button.

MicroMove can be used with the following functions:

• Set markers («MARKERS»)
• Place design with sewhead («GRAB/DROP»)
• Set boundary («BOUNDARY»)
• Mask design («MASK»)
• Trim design («TRIM»)
• Align design («ALIGN»)
• Alter design size («RESIZE»)
• Realign the safe area («REALIGN SAFE AREA»)

Prerequisite:

• A design is selected in the «Quilt Design Area».

> Tap a function in the «Tool Center».
– The settings window for the function opens in the software.

– With some functions, the «Set» window opens on the display of the machine at the same time.

– For some functions, «Sewhead» must be selected in the settings window in the «CONTROL» area.

1

2

> Move the sewhead close to the desired position.
> Tap «MicroMove» (1).
> Select the size of the microsteps (2).



CREATIVE QUILTING

24

> To move the sewhead in microsteps, press the toggle switches on the handles. 
Right handle, toggle switch I: Move the sewhead to the right
Right handle, toggle switch II: Move the sewhead to the left
Left handle, toggle switch I: Move the sewhead backward
Left handle, toggle switch II: Move the sewhead forward.

> To move the sewhead in increments, briefly press the corresponding toggle switch.
> To keep moving the sewhead, press and hold the corresponding toggle switch.

Set > To set the point or the line, tap «Set».

> When all points and lines are set, deactivate «MicroMove» (1).

NOTICE! As long as MicroMove is activated, the machine cannot be moved by hand.

Markers

Designs can be positioned precisely using markers. Several markers can be connected to one object. Such an
object can be moved, edited, sewn out or deleted like any other design.

> Click «Markers».

– The «Set» window opens on the display of the machine.

> To set a marker, place the sewhead over the desired place, using «MicroMove» where applicable. (see
page 23)

> Tap «Set» on the screen of the machine or press any toggle switch.
– The marker is transferred to the «Quilt Design Area».

> Set further markers in the same way.
> To connect the markers with each other, activate «Connect Markers» and click on all markers in turn on

the Q-matic screen.
– The markers are connected with a line to form an object.

> To display the center of all markers, click «Center».

CLR > If necessary, delete all markers and the object line.

> Once markers are set as desired, click «Confirm».

Boundary

Designs can be placed precisely within boundary lines with the «Boundary» function. Boundary lines can be
created with the sewhead or using the software. The design can be positioned within the boundary lines
with unaltered proportions or distorted.

> Click «Select» and select a design in the «Quilt Design Area».
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> Click «Boundary».

> In the CONTROL area, select whether the boundary lines are set with the sewhead or using the software.
> In the PLACEMENT METHOD area, select the type of boundary lines.
> In the OPTIONS area, select the settings.

– The selected settings are displayed in the preview.

> If necessary, undo the settings.
> Once the design is displayed as desired, tap «Confirm».

CONTROL

Operating
Component

Purpose Preview

«Screen» Carry out the function on the Q-matic
screen.

> Set the points on the Q-matic
screen.

«Sewhead» Carry out the function with the
sewhead.

> For each point, guide the needle to
the desired position and tap «Set»
to transfer the spot.
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PLACEMENT METHOD

Operating
Component

Purpose Preview

«Two Point» Position the design on a line drawn
between two points.

> Set two points, starting by setting
the left spot and then setting the
right spot.

«Four Point» Position the design within a
quadrilateral boundary.

> Set four points, starting at the
bottom left and setting points in
counterclockwise order.

«Multiple Point» Position the design within a polygonal
boundary.

> Set the desired number of points
and close by pressing «Close
Boundary».

> Select four points as a positioning
guide, starting at the bottom left
and selecting points in
counterclockwise order.

«Morph to Fit», «Maintain Ratio» and «Center Stretch» OPTIONS

Option «Morph to Fit» «Maintain Ratio» «Center Stretch»

Placement Method

«Two Point» Not possible

«Four Point»
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Option «Morph to Fit» «Maintain Ratio» «Center Stretch»

Placement Method

«Multiple Point» Not possible Not possible

«Center Horizontally» and «Center Vertically» OPTIONS

«Center Horizontally» and «Center Vertically» can be combined using the «Four Point» positioning method
and the «Maintain Ratio» and «Center Stretch» options. The size of the design is based on the available
distance to the nearest edge of the boundary frame.

Option Purpose Preview

«Center Horizontally» Align the design along the center line
of the longer horizontal edge.

«Center Vertically» Align the design along the center of
the longer vertical edge.

«Center Horizontally»
and «Center Vertically»

Combination of «Center Horizontally»
and «Center Vertically»

«Margin» OPTIONS

«Margin» can be used to set the distance between the design and the boundary frame.
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Grab and Drop

«Grab/Drop» is always active if a design from the «Design Center» is placed in the «Quilt Design Area».

«Grab/Drop» can also be activated in order to move a design. When doing so, the design is grabbes with the
needle and can be dropped on the quilt with the sewhead in the desired place.

> Click «Select» and select a design in the «Quilt Design Area».

> Click «Grab/Drop».
– The start spot of the active design is grabbed with the needle.

> Move the sewhead so that the needle is over the desired place, using «MicroMove» where applicable.
(see page 23)
– In the «Quilt Design Area» the design is pulled along.

> Click «Grab/Drop» again or press a toggle switch on one of the handles.
– The starting point of the design is placed at the needle position.

Multiply

Designs and rows of designs can be multiplied horizontally and vertically with the «Multiply» function.
Simultaneously, the designs can be mirrored. The designs are not connected. The spaces between the
designs can be enlarged or reduced.

> Click «Select» and select a design in the «quilt design area».

> Click «Multiply».

> Multiply the designs horizontally in the ACROSS area. To do so, enter the number of designs in the input
field and add these with «+» or remove them with «-». If necessary, mirror the inserted designs in the
«Flip» area.

> Multiply and mirror the designs vertically in the DOWN area.
> In the SPACING (INCHES) area, set the distances and the offset between designs.
> Once the designs are displayed as desired, click «Confirm».

ACROSS and DOWN

Operating Component Purpose

«Flip» Mirror designs.

«Hor» Mirror horizontally.
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Operating Component Purpose

«Vert» Mirror vertically.

«All» Mirror all designs.

«Alt» Mirror every second design.

SPACING (INCHES)

Entry Field Purpose

«Horizontal» Enter increment for horizontal distance.

«Vertical» Enter increment for vertical distance.

«Offset» Enter increment for offset between rows of designs.

Deleting quilt designs

> Click «Select» and select a design in the «Quilt Design Area».

> Click «Delete».
– The design is removed from the «Quilt Design Area».

5.3 Modifying the Design

Moving Quilt Designs

> Click «Select» and select a design in the «quilt design area».
> Move the design.

> Click «Select».

Copy

> Click «Select» and select a design in the «quilt design area».

> Click «Copy».
– The copied design is inserted with the start spot at the current needle position of the machine. If

several copies are inserted and the machine is not moved, all copies are inserted on top of each other.

> Click «Select».

Rotate

The design can be rotated freely or in individual increments. Each point of the grid can be selected as a
rotation point.

> Click «Select» and select a design in the «Quilt Design Area».
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> Click «Rotate».

– The design is surrounded by a grid. The red dot marks the point of rotation.

> Select the point of rotation in the METHOD area.
> Set the angle of rotation in the ANGLE area.

– The rotation is shown in the preview.

> Once the design is displayed as desired, click «Confirm».

METHOD

Option Purpose Preview

«Select point of
rotation»

Press and hold the desired point of
rotation until it turns red.

«Start Point» Set the start point of the design as a
point of rotation.
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Angle

Option Purpose

«Enter Angle» Enter angle of rotation.

«Apply» Confirm entry.

Rotate design 0.1° clockwise.

Rotate design 5° clockwise.

Rotate design 45° clockwise.

Rotate design 0.1° counterclockwise.

Rotate design 5° counterclockwise.

Rotate design 45° counterclockwise.

Mirror and Flip

Designs can be mirrored on a horizontal or vertical axis.

> Click «Select» and select a design in the «Quilt Design Area».

> To mirror the design on a vertical axis, click «Mirror».

> To mirror the design on a horizontal axis, click «Flip».

Mask

Masking is a partial concealment of a quilt design, as under a mask. A shape or another design can be used
as a mask.

Creating a Mask from a Design
> In the «Quilt Design Area», position a design as a background design.
> Position a second design as a mask over the top of the background design, as desired.
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> Click «Select», then click the background design.

> Click «Mask».

> Click «Screen» in the CONTROL area.
> Click «Selected Design» in the METHOD area.
> In the REGION TO REMOVE and SEW MASK OUTLINE areas, select the desired options.
> Click the mask in the «Quilt Design Area».

– The mask is displayed in black.

Preview > To display a preview, click «Preview».
– The design is displayed masked with the selected options in the «Quilt Design Area».

> Once the design is displayed as desired, click «Confirm».

Creating a Mask from a Shape
> In the «Quilt Design Area», position a design as a background design and select it.

> Click «Mask».
> Click «Sewhead» or «Screen».
> Click «Create Region».
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> Create a shape from multiple spots using the sewhead or in the «Quilt Design Area».
– The mask is displayed in the «Quilt Design Area» as a black shape.

> Set the options as desired.

Preview > Display the preview.
– The design is displayed masked with the selected options in the «Quilt Design Area».

> Once the design is displayed as desired, click «Confirm».

Setting Options

REGION TO REMOVE «Inside» «Outside»

SEW MASK OUTLINE

«Sew Mask Outline»
activated

«Sew Mask Outline»
deactivated

Trim

Designs can be trimmed along a horizontal, vertical or diagonal line.

> Click «Select» and select a design in the «Quilt Design Area».
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> Click «Trim».

> In the «CONTROL» area, select how the function is to be carried out.
> In the «METHOD» area, select what is to be trimmed.
> In the «TRIM LINE ORIENTATION» area, select the orientation of the trim line.
> In the «INVERT» area, select which part is to be trimmed.
> In the «JUMP STITCH» area, select whether or not jump stitches are to be sewn.

Preview > To display a preview, click «Preview».
– The design is displayed trimmed with the selected options in the «Quilt Design Area».

> Once the design is displayed as desired, click «Confirm».

Operating
Component

Purpose Preview

CONTROL

«Screen» Carry out the function on the Q-matic
screen.

«Sewhead» Carry out the function with the
sewhead.

METHOD

«Selected Design» Trim the selected design.
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Operating
Component

Purpose Preview

«Entire Quilt» Trim the entire quilt.

TRIM LINE ORIENTATION

«Horizontal» Set a horizontal trim line.

«Vertical» Set a vertical trim line.

«Angle» Set a diagonal trim line.

> Click «Start Point» and set a spot to
use as the start point of the trim
line.

> Click «End Point» and set a spot to
use as the end point of the trim line.
– The diagonal trim line is

transferred to the «Quilt Design
Area» and displayed as a red line.
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Operating
Component

Purpose Preview

«Invert» Invert the cutting area. Parts of the
design shown in black will be trimmed
off.

«Jump Stitch» Activate/deactivate Jump Stitch.

If «Jump Stitch» is activated, the jump
stitches will not be sewn out, and the
stitches are displayed in gray.

If «Jump Stitch» is not activated, the
jump stitches will be sewn out, and the
stitches are displayed in red.

Reverse Sew

Each design has a defined start and end point. The start point is green and the end point is red. These
determine in which direction the design is sewn. The sewing direction can be changed with «Reverse Sew».

> Click «Select» and select a design in the «Quilt Design Area».

> Click «Reverse Sew».
– The start and end point of the design are switched, the design is sewn in the opposite sewing

direction.

Connect

Q-matic offers three options for interconnecting designs:

• Group: The designs are put together into one group and can be edited as one design.
• Attach: The start point of a design is connected to the end point of the selected design.
• Link: The start point of a design is connected to the end point of the selected design with a joining seam.

> Click «Select» and select a design in the «Quilt Design Area».
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> Click «Connect».

> Select the type of connection in the METHOD area.
> Click other designs in the «Quilt Design Area».
> Click «Confirm».

– Designs are sewn out in the order in which they were clicked.

Operating
Component

Purpose Preview

«Group» Group designs.

The designs (red) are put
together into one group and
can be edited as one design.
They remain in their position
and are sewn out as a group.

«Attach» Attach designs.

The start point of the second
design is connected directly
to the end point of the
selected design. One design
is created.

«Link» Link designs.

The start point of the second
design is connected to the
end point of the first design
with a joining seam. The
connected designs remain in
their position and are sewn
out as a single design.

Unconnect

Designs that were connected with the «Connect» function can be separated. Not all connections are
separated at the same time, but rather in the order in which they were put together.

Even designs that have one jump stitch or several jump stitches can be separated.
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> Click «Select» and select a connected design in the «Quilt Design Area».

> Tap «Unconnect».
– The designs are separated.

Align

Several designs can be aligned with each other in different ways.

> Click «Align».

> In the «CONTROL» area, select how the function is to be carried out.
> Select the alignment of the designs in the «ALIGNMENT ORIENTATION» area.
> Place line.
> Select design.

– The aligned designs are shown in the «Quilt Design Area».

> Once the design is displayed as desired, click «Confirm».

Operating
Component

Purpose Preview

CONTROL

«Screen» Carry out the function on the Q-matic
screen.

«Sewhead» Carry out the function with the
sewhead.

ALIGNMENT
ORIENTATION

Select alignment: Top, bottom, centered
horizontally, left, right or centered
vertically.
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Operating
Component

Purpose Preview

«Place Line» Set orientation line.

«Select Design» Select design.

Resize

The design size can be altered proportionally or non-proportionally.

> Click «Select» and select a design in the «Quilt Design Area».

> Click «Resize».

> In the CONTROL area, select how the design size is to be altered.
> In the SIZE area, enter the design width and/or the design height.
> In the MAINTAIN RATIO area, select whether the size is to be altered proportionally or non-

proportionally.
> If necessary, undo settings.
> Once the design is displayed as desired, click «Confirm».
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CONTROL

Operating Component Purpose Preview

«Screen» Carry out the function on the Q-
matic screen.

> Drag the green spot away
from the opposite spot.

> If necessary, set a green spot
by tapping another spot and
holding until it is displayed in
green.

«Sewhead» Carry out the function with the
sewhead.

> Set the start point.
> Drag the machine diagonally

away from the start point.
> Set the end point.

«Keypad» Enter details via the keyboard.

SIZE

Operating Component Purpose Preview

Width Input field for the design width.

> Enter width with the
keyboard.

Height Input field for the design height.

> Enter height with the
keyboard.
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MAINTAIN RATIO

Operating Component Purpose Preview

«Maintain Ratio» activated. Alter the design size
proportionally.

«Maintain Ratio» deactivated Alter the design size non-
proportionally.

5.4 Exchanging with Art & Stitch

For further changes to designs, it is recommended to transfer the design to the Art & Stitch software, edit it
there and transfer it back to Q-matic. It's better to perform extensive work on a separate PC with mouse
operation.

Further information and instruction manuals for Art & Stitch can be found on the website

https://www.artandstitch.com, and in the program under the Help function.

> Click «Select» and select a design in the «quilt design area».

> To transfer the design to Art & Stitch, click the «Art & Stitch» icon.
– Art & Stitch is opened and the design is transferred.

> Edit the design in Art & Stitch.
> Before the design is transferred to Q-matic, set the «Line Sew Type» to «Running stitch».
> Save the design in the «Documents» folder or another folder with the file extension .ans.
> To transfer the altered design to Q-matic, click the «Q-matic» icon.

– The design is shown in the «Quilt Design Area» of Q-matic.

> Import the design into the «Design Pool». (see page 47)

5.5 Pantograph

Creating pantographs

Designs suitable for pantographs can be combined using the functions «E2E+», «E2E-» and «Multiply». The
rows of designs can be mirrored horizontally and vertically, and the distances between the rows of designs
can be changed.

Creating a Row of Designs

Prerequisite:

• A pantograph design is placed in the «Quilt Design Area».

> Click «Select» and select a design in the «Quilt Design Area».

> To add a design to the row, click «E2E+».

> To remove a design from the row, click «E2E-».

https://www.artandstitch.com
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Multiplying Rows of Designs
> Click «Multiply».

> In the «DOWN» area, specify and mirror the desired number of rows of designs.
> In the SPACING (INCHES) area, set the distances and the offset between designs.
> Once the designs are displayed as desired, click «Confirm».

Realign Safe Area

This function is used primarily for pantograph quilting. The Safe Area can be repositioned to the actual
needle position in the «Quilt Design Area» after advancing the quilt, in order to ensure that the next rows of
the pantograph can be precisely sewn.

Prerequisite:

• A pantograph has been created in the «Quilt Design Area» and the first rows of the pantograph have
been quilted.

• The selected Safe Area is large enough that at least one row of the pantograph can be positioned within
it.

> Advance and baste the quilt.
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> Look for a distinctive spot in the middle of the design and position the needle over that spot.

– In the «Quilt Design Area», the needle will still be at the old position (A) before the quilt was
advanced. It must now virtually be moved to the actual needle position (B).

A

B

> Click «Realign Safe Area».
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> Click «Set» under «SET GUIDE LINE».
– In the «Quilt Design Area», a vertical guide line will be shown at the actual needle position.

> Move the Safe Area using either «Reposition on Screen» or «Snap to Point».

Repositioning the Safe Area using Reposition on Screen
> Click «Reposition on Screen».
> Move the needle cross in the «Quilt Design Area» near the actual needle position.
> Zoom in on the area around the actual needle position and position the needle cross precisely at the

actual needle position using the nudge buttons.

> Click «Confirm».
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Repositioning the Safe Area using Snap to Point
> Click «Snap to Point».
> Zoom in on the area around the actual needle position.

> Click the actual needle position.

> Click «Confirm».
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6 Managing Designs

6.1 Saving a quilt project

AutoSave

Quilting projects are automatically saved to the project folder at regular intervals in the «AutoSave» folder.

Saving Manually

Quilting projects can also be saved in any filing location.

> In the menu bar, click «File» —> «Save» —> «Save project».
– Explorer will now open.

> Enter the file name of the quilting project.
> Click «Save».

– The quilting project is saved in .bqp format in the «Projects» folder.

6.2 Opening a quilt project

Saved quilting projects can be opened and changed. Before a project can be opened, the open project must
be saved and closed.

> In the menu bar, click «File» —> «Open project».
– A new window opens.

> Open the desired storage medium in Explorer.
> Select the desired project in .bqp format.

– The selected quilting project is opened.

6.3 Creating a new quilt project

Prerequisite:

• If a quilting project is opened, it must first be saved.

> In the menu bar, click «File» —> «New project».
– A new window opens.

6.4 Deleting quilt projects

Self-created quilting projects can be deleted.

> In the menu bar, click «File» —> «Delete» —> «Delete project».

1

> Activate the quilting project you want to delete in area (1).
– The selected quilting project is highlighted in blue.

Delete > Click «Delete».
> To delete the quilting project, click «Yes».

Close > To close the window, click «Close».
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6.5 Saving quilt designs

Self-created or altered designs can be saved in Explorer or on a USB stick.

Saving a Design in Explorer

Prerequisite:

• A design is activated.

> In the menu bar, click «File» —> «Save» —> «Save design file».
– Explorer will now open.

> Enter the file name of the design.
> Click «Save».

– The design is saved in .bqm format in the «Designs» folder.

– The design can be imported into the «Design Pool». (see page 47)

Saving a Design on a USB Stick

Prerequisite:

• A design is activated.

> Insert the BERNINA USB stick into a USB connection on the Q-matic PC.
> In the menu bar, click «File» —> «Save» —> «Save Design File».

– Explorer will now open.

> Click the USB stick in Explorer.
> Enter the file name of the design.
> Click «Save».

– The design is saved in .bqm format on the USB stick.

– The design can be edited on another PC.

6.6 Importing quilt designs

Designs in .bqm and .dxf formats can be imported.

Importing a Design from Explorer
> In the menu bar, click «Design Library» —> «Import Design».

1 2 3

4

5

> In «Explorer» (1), select the folder in which the designs are stored.
– The designs are shown in the «Files» (2) area.

> Click the desired design under «Files» (2).
– The design is shown as a preview under «Design Preview» (3).

> Double-click the desired design under «Files» (2).
– The name of the design is shown under «Importing» (4).

Select All > Click «Select all» under «Files» (2).
– All designs are shown under «Importing» (4).
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> Assign the desired tags (5) to the design.

Import > To import the design into the «Design Pool», click «Import».
– The design name is shown in the «Files» display with the addition of «Imported».

Close > Close the window.
– The designs are visible in the «Design Pool».

Importing a Design from a BERNINA USB Stick
> Insert the BERNINA USB stick into a USB connection on the Q-matic PC.
> In the menu bar, click «Design Library» —> «Import Design».
> Open the BERNINA USB stick in Explorer.
> Import design.

6.7 Deleting the Design

Designs can be deleted from the «Design Center» and from the «Design Pool».

Removing a design from the «Design Center»

For a better overview, it is recommended that you remove designs that are not needed for the project from
the «Design Center».

> Activate «Design Pool».

1

> To remove just one design from the «Design Center» (1), double-click the design.

Clear All > To remove all designs from the «Design Center», click «Clear All».

Close > To close the window, click «Close».

Removing a design from the «Design Pool»

Remove individual designs from the «Design Pool».

> In the menu bar, click «File» —> «Delete» —> «Design File».
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> Click the design which is to be deleted.
– The selected design is highlighted in color.

Delete > Click «Delete».
> To remove the design, click «Yes».

Close > To close the window, click «Close».

6.8 Tagging Designs

Designs can be provided with tags. For example, tags can be created according to the designer, form and
type. Tags make searching for suitable designs easier.

Managing Tags

Tags can always be altered or deleted.

> In the menu bar, click «Design Library» —> «Manage Tags».

1

2

3

> To add a tag, click «Add» (1).
> Type in the tag and click «Confirm».
> To alter a tag, click the desired tag and click «Modify» (2).

> Alter the tag and click «Confirm».
> To delete a tag, click the desired tag and click «Delete» (3).

Close > To close the window, click «Close».
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Assigning/Removing Tags

A tag can be assigned to a design so that it is more easily found.

> In the menu bar, click «Design Library» —> «Design Tags».

1 2 3

> In the «Design Pool» (1), double-click on one or all designs that you want to give the same tag.
– The selected designs are shown under «Selected Designs» (2) and highlighted in gray in the «Design

Pool» (1).

> To assign tags, activate the desired ones under Tags (3) and click «Add Tags».
> To remove tags, activate the ones to be removed under Tags (3) and click «Remove Tags».

Close > To accept the changes and close the window, click «Close».
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7 Automatic Quilting

7.1 Sew Options

The sewing sequence of the designs and the features of the securing stitches can be set in the sew options.

Activating the Function

2
1

3
> Click «Sew Options».

Determining a Sewing Sequence
> Click «Select» in the «SEWING SEQUENCE» area.
> In the «Quilt Design Area», click the designs in the order in which they should be sewn.

– The designs are numbered.

Editing a Queue

Designs can be removed from the queue or put in the queue at any time in the «QUEUE» area.

> To remove a design from the queue, click «Dequeue» and click on the designs that you don't want to be
sewn.
– Designs are shown in gray.

> To remove all designs from the queue, click «Dequeue All».
> To put a design in the queue, click «Queue» and then click all designs that are to be sewn.

– Designs are shown in blue.

> To put all designs in the queue, click «Queue All».

Setting Securing Options

Settings for securing stitches can be applied in the «TIE ON/TIE OFF» area.

> To sew securing stitches at the start of the seam, activate «Tie on».
> If you don't want to sew securing stitches at the start of the seam, deactivate «Tie on».
> To sew securing stitches at the end of the seam, activate «Tie off».
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> If you don't want to sew securing stitches at the end of the seam, deactivate «Tie off».
> To set the length of the securing stitches, activate the desired length under «Length».
> To set the number of securing stitches, set the desired value under «SPI».
> Once all sewing settings are set as desired, click «Confirm».

7.2 Sewing Quilt Designs

All designs in the queue that are within the «Safe Area» can be sewn.

Prerequisite:

• A design in the queue is within the «Safe Area».
• «Sewing» is activated.

> If desired, activate «Pause to pull bobbin».
> To start sewing, click «Start».

> Click «At START point».
– The window is closed and the machine moves to the start point of the design.

> Pull up the bobbin thread in one step or

> pull up the bobbin thread in two steps.

> If necessary, activate or deactivate securing stitches.

> Click «Confirm».
– The machine starts sewing the design.

7.3 Interrupting Sewing

Sewing can be interrupted, e.g. to adjust the thread tension or the SPI (stitches per inch).

Prerequisite:

• The machine is sewing.
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> To interrupt sewing, click «Pause» on the machine or on the Q-matic PC.

1

2

> Adjust the «SPI» (1) on the screen of the machine.
> Adjust the thread tension (2) on the screen of the machine.
> To confirm the changes and continue sewing, click «Confirm».

7.4 Continuing Sewing after a Thread Break

If the upper thread breaks or the bobbin thread indicator detects the end of the bobbin thread (only if the
bobbin thread indicator is switched on), the machine stops automatically after a few stitches. The needle can
be repositioned and sewing can be continued with the quilt sequence control function.

> After a thread break, change the bobbin or rethread the upper thread.
> Click to dismiss all error messages on the machine and in the software.
> To continue sewing, click «Start».

> To confirm the query on the screen, click «Confirm».

> Position the needle near the point where the thread broke.
> Click «At closest point on design».

– The window is closed and the machine moves the needle precisely onto the design.
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> Pull up the bobbin thread.

> Click «Confirm».
– The window is closed and the machine continues sewing.

7.5 Canceling Sewing

Prerequisite:

• The machine is sewing.

> To cancel sewing, click «Stop».

> Click «Start».

> Click «Cancel».
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8 Settings

8.1 Activating/Deactivating Securing Stitches

Securing can generally be activated or deactivated in the «Tools» --> «Sew Options» menu, or in the Tool
Center under «Sew Options». In addition, securing can be deactivated or activated on a case by case basis
upon starting sewing.

> To activate or deactivate securing in individual cases, switch «Securing Stitches» on or off on the machine
in the «Tie on/Pull Bobbin» window.

8.2 Sewing On/Off

With «Sewing», you can set whether the machine should sew the design, or just trace without sewing.

This function is available in the settings menu («Settings» --> «Sewing») and in the «Control Area».

> To sew a design, activate «Sewing».
> To just trace a design, deactivate «Sewing».

8.3 Activating/Deactivating Sounds

In the settings menu, you can set whether an acoustic signal should sound each time the screen is operated.
The signal can be selected in the Windows settings.

> To activate sounds each time the screen is operated, activate «Settings» —> «Sound» in the menu.
> To deactivate sounds each time the screen is operated, deactivate «Settings» —> «Sound» in the menu.

8.4 Easy Glide

«Easy Glide» makes it easier to manually move the machine on the quilting frame.

After starting the software, «Easy Glide» is always activated.

Activating/Deactivating Easy Glide
> To activate or to deactivate Easy Glide, click «Easy Glide».

Setting the Support

The support when manually moving the machine can be set separately for the X direction and Y direction.

It should be possible to manually move the machine by applying a comfortable amount of force. If the
machine can only be moved with difficulty, increase the support. If the machine continues moving on its own
after being pushed, decrease the support.

To prevent the machine colliding with the frame or the Q-matic PC, the support should be set so that the
machine comes to a stop on its own.
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> Click «Settings» --> «Easy Glide Settings» in the menu.

1

2

> Set the support for the X-axis (1) between 0 and 40 and the Y-axis (2) between 0 and 20.

Accept > Click «Accept».
– The settings are applied and the window is closed.
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9 Maintenance

9.1 Reinstalling Windows

Information on reinstalling Microsoft Windows can be found here: https://support.microsoft.com/windows

9.2 Installing/Updating the Q-matic Software

Reinstall or Update the Q-matic Software/Firmware

When reinstalling or updating the software and firmware files for Q-matic, the following components must
be updated together to the latest version:

1. Q-matic software (user interface on the Q-matic PC, incl. control cabinet software)
2. Q Series firmware (machine) incl. Q-matic bootloader

More information and software updates can be found at: www.bernina.com/longarm.

Saving your personal program, design and project data is recommended before a reinstallation or a software
update.

When installing Q-matic with the supplied USB stick, the software does not have to be downloaded, but can
be installed according to the section on «Installing Software». (see page 58)

Downloading Software

To update the BERNINA Q-matic software installed on the Q-matic PC, the new version of the software must
first be downloaded.

Note: The "X" in the example files stands for the software version.

> Open the Internet browser and enter «https://www.bernina.com/support» in the address bar.
> Click on the «Search support info for BERNINA models» tab and select "BERNINA Q-matic".
> To download the file, click on the link «BERNINA Q-matic Software xx.xx.xx».

– Normally, the file is downloaded to the «Downloads» directory.

> Once the download is complete click on the «Open Folder» button.

– «Downloads» directory is openend.

https://support.microsoft.com/windows
https://www.bernina.com/longarm
https://www.bernina.com/support
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Unpacking Software

On a Windows Computer

Prerequisite:

• The USB stick is formatted to FAT32 and inserted into the computer.

> Right-click on the ZIP file «BERNINA_Q-matic_PC-Setup xx.xx.xx.zip» and select «Extract all …» from the
context menu.

> If a security warning is displayed, allow the unpacking to continue and do not cancel. Otherwise, the
folder will not be unpacked.

> Click on the «Browse...» button and select the USB stick as the target folder. When doing so, ensure that
the unpacked files are saved directly onto the top level of the USB stick.

> Check the box for «Show extracted files when complete» and click on the «Extract» button.

– As soon as the file has been extracted, the USB stick opens with the Q-matic installer file.

> Eject and remove the USB stick.

On a Mac Computer

Prerequisite:

• The USB stick is formatted to FAT32 and inserted into the computer.

> Unpack the «BERNINA_Q-matic_PC-Setup xx.xx.xx.zip» ZIP file with a double click.
– The contents of the ZIP file will be copied to a folder.

> Drag files from the folder to the USB stick.
> Eject and remove the USB stick.

Note: For newer software versions, the ZIP file stored in the downloads folder may have been already
unpacked.

Installing Software

Prerequisite:

• The control cabinet is switched on and connected with the Q-matic PC. The LED on the control cabinet is
illuminated in green.

• The Q-matic installation file can be found on the BERNINA USB stick.
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> Insert a BERNINA USB stick with the new software version into a USB connection of the Q-matic PC.
> Open the USB stick folder.

> Double-click on the «Q-matic-xxx-Fullinstaller.exe» file.
– The installer starts.

> Confirm that the installer is allowed to make changes by answering the query with «Yes».
> Confirm all queries with «Next» and start installation with «Install».
> Confirm the query Installation Silicon Laboratories with «Next».

> Agree to the license agreement with Silicon Laboratories and confirm with «Next».



MAINTENANCE

60

> Confirm the installation of Silicon Laboratories with «Finish».

> Wait until the installation is complete.

> To finish the setup wizard, select «Yes, restart the computer now» and tap «Finish».

Updating Control Cabinet Firmware
> Start Q-matic software.

– If the firmware of the control cabinet is not up to date, you are requested to update it.

> Confirm the request to install the control cabinet firmware with «Yes» and wait until the installation is
finished.

> Confirm that installation is finished with «OK».
> Eject and remove the USB stick.
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> Switching off the Q-matic system. (see page 19)
> Starting the Q-matic system. (see page 19)
> Check the version of the software and the control system.

Updating the Machine Firmware

During the installation of the Q-matic software, a «Q Series Firmware» folder is created on the desktop. The
folder contains the subfolders «Q16-PLUS» and «Q20-24» with the firmware files for the respective machine
type.

> Open the «Q Series Firmware» folder.
> Copy files from the subfolder of your machine type onto the BERNINA USB stick and eject the USB stick.
> Insert the USB stick into the USB port of the Q series machine.
> Tap «Home».

> Tap «Settings».

> Tap «Machine».

> Tap «Maintenance».

> Tap «Firmware Update».

Update > To start the firmware update, tap «Update».

NOTICE Incomplete update due to removing the BERNINA USB stick too early
If the software has not been updated or has not been fully updated, the machine cannot be used.
> Remove the BERNINA USB stick only once the update has been successfully completed.

9.3 Installing/Updating Art & Stitch Software

When installing the Q-matic software, Art & Stitch is also updated at the same time if an older version was
present on the computer.

Saving your personal data before an installation or update is recommended.

More information and software updates can be found at: http://artandstitch.com

If problems arise with the update, ask Art & Stitch.

9.4 Replacing the Q-matic PC

If the Q-matic PC is no longer working, buying one from a BERNINA specialist is recommended. This has the
advantage that all programs that are required for the Q-matic system are already installed. This guarantees
compatibility with the entire Q-matic system. So the new PC merely needs to be installed and connected.
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10 Errors and Faults

10.1 Troubleshooting

Fault Cause Solution

The Q-matic doesn't start. The emergency stop button is still
activated.

> To release the emergency stop button, turn the red
button in the direction of the arrow.

Q-matic is not switched on. > Press and hold the green button for three seconds until
you hear a click.

LEDs illuminate or flash after the
start-up process on the control
and power supply cabinet or X/Y
drives.

> Further information (see page 64).

«Safe Area» cannot be set. Coupling of the X and Y belt
clamp is not closed.

> Ensure that the couplings of the X and Y belt clamps are
closed.

Design is not correctly sewn out. Design is only sewn in the Y-axis
or X-axis.

> Ensure that the couplings of the X and Y belt clamps are
closed.

Too little free memory on the
BERNINA USB stick.

Not enough free memory
available on the BERNINA USB
stick.

> Make sure that the BERNINA USB stick is being used.
> Delete data from the BERNINA USB stick.

No BERNINA USB stick is inserted. No BERNINA USB stick has been
inserted.

> Use a BERNINA USB stick with enough free space.
> Make sure that throughout the entire update the same

BERNINA USB stick always remains inserted.

After pushing the machine, the
machine moves further on its
own.

Anti-friction property of the
machine set too high.

> Change the anti-friction property of the machine. (see
page 55)

Q-matic screen remains black Computer is in energy-saving
mode or in sleep mode.

> Press the on/off button on the screen.

The Q-matic has not been started
because the green button was
pressed only briefly.

> Press and hold the green button for three seconds until
you hear a click.
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10.2 Error messages Q-matic software

Message on the Display Cause Solution

The system has reported a fault:
A thread break fault has
occurred.

The upper thread is used up. > Rethread. Restart the machine with «Start», (see
page 53).

The upper thread is broken.

The system has reported a fault:
A thread break fault has
occurred.

The bobbin thread is used up. > Rethread. Restart the machine with «Start», (see
page 53).

The bobbin thread is broken. > Clean the hook.
> Rethread. Restart the machine with «Start», (see

page 53).

The system has reported a fault:
There is a problem with the
machine. Please check the
sewhead.

The machine is not switched on. > Switch the machine on.

Connecting cable to Q-matic
system not plugged in.

> Plug in cable.

A design is partially outside of
the safe area or there are no
queued designs in the safe area.

A design is partially outside of
the «Safe Area».

> Reposition a design in the «Safe Area» or realign the
«Safe Area». (see page 42)

> Requeue the design. (see page 51)

The system has reported a fault:
The controller has lost
communication with the motor
drives. Please ensure the STOP
button is not pressed.

The motor drive is not working.

Both or just one of the LED
indicator lights are/is illuminated
in «orange» on the X/Y drive.

> Ensure that the connectors of both cables are correctly
inserted or are not defective.
– Both LED indicator lights are illuminated in «green».

> Realign the «Safe Area». (see page 42)
> Restart the machine with «Start».

The system has reported a fault:
An X-axis fault has occurred. The
controller has lost
communication with the motor
drives. Please ensure the STOP
button is not pressed.

The X/Y drive control system is
not working.

Both or just one of the LED
indicator lights are/is illuminated
in «orange» on the X/Y drive.

> Ensure that the connectors of both cables are correctly
inserted or are not defective.
– Both LED indicator lights are illuminated in «green».

> Realign the «Safe Area». (see page 42)
> Restart the machine with «Start».

The system has reported a fault:
A needle fault has occurred.

Moving the handwheel while
positioning the sewhead.

> Restart the Q-matic system.

The sewhead is too far away
from any design. Please
reposition the sewhead then click
Start.

The sewhead is too far away
from the design.

> Move the sewhead closer to the design.

The system has reported a fault:
A sequence fault has occurred.

The machine is not switched on.
Machine is using an old firmware
version.

> Switch the machine on.
> Update the machine firmware.

The system has reported a fault:
Unable to sew because designs
are too large.

The design is too large. The
created design is too long (length
or number of stitches) and can
therefore not be processed.

> Make the design smaller or divide the design into
smaller pieces in «Art & Stitch».
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10.3 Q-matic system status and troubleshooting

System Status Display

LEDs display the system status on the control cabinet, as well as on both drive motors.

Fig. 1: LEDs on the control cabinet

Fig. 2: LEDs on the drive motors

Troubleshooting

During the start-up process, all the LEDs illuminate and flash. As soon as the system has started up error-free,
only the green LEDs will illuminate. If, after starting, other LEDs illuminate or flash, there is an error.

> If there is an error, switch off the system and disconnect it completely from the power supply.
> Plug in the power cable again and restart the system.
> If the error persists after the second restart, switch off the system.
> Check whether the USB cable is correctly connected to the Q-matic PC. Reconnect the cable if required.
> Check whether the power cable to the machine is correctly connected. Reconnect the cable if required.
> Restart the system again.
> If the error persists, contact a BERNINA specialist or BERNINA technical support.
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11 Appendix

11.1 Overview Quilt Designs

Tips around the Quilt Designs

The designs are are digitized geometrically with great precision. The Q-matic system also sews these out very
accurately. Nevertheless, inaccuracies may be visible with large designs due to shrinkage of the fabric layers
during the quilting process.

Measures for Minimizing Shrinkage
• Before beginning to quilt, stabilize the quilt block and the quilt sandwich with basting stitches.
• For designs with frames, always sew first the outer and then the inner portions.
• Clamp both the top of the quilt and the backing fabric, i.e. do not simply float the fabric.
• Clamp the backing fabric on the side with side clamps. Never change this clamping during quilting.
• Do not lean or support your arms on the front rails during quilting.
• In case of extreme enlargements or reductions of the designs, first sew out a quilt sample.

Jump Stitch

For some designs, the machine must jump from one place to another without sewing, so as to continue
sewing there. These jumps from one spot to another are named jump stitch. Q-matic can be set so that the
machine stops before a jump stitch, for the purpose of securing and to cut the thread. If the setting is
deactivated, a long stitch is created which must later be processed. Designs that contain jump stitches are
marked in the design overview with the number of jump stitches.

Supplied Designs

To find further information on the well-known designers and quilters who created the designs included in
BERNINA Q-matic, please search for their names online and visit their websites or blogs. Q-matic includes
designs from Amanda Murphy, Keryn Emmerson, Patricia Ritter, Aggy Burczyk, Basic Shapes by AB, Alfonsina
Uriburu, Linzi Upton, Gerda Raschle, Lisa Calle, etc.

Amanda Murphy

Name Quilt Design Name Quilt Design

AM_Bloom_Block1 AM_Bloom_Block2

AM_Bloom_Borders AM_Bloom_corner

AM_Bloom_E2E AM_Bloom_Motif
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Name Quilt Design Name Quilt Design

AM_Bloom_Triangle AM_ModernArcs_Block

AM_ModernArcs_
Border

AM_ModernArcs_
Corner

AM_ModernArcs_E2E1 AM_ModernArcs_E2E2

AM_ModernArcs_Motif AM_ModernArcs_
Triangle

LoopedFlowers_
Border

LoopedFlowers_
Border_L

LoopedFlowers_
Corner

LoopedFlowers_
Panto1

LoopedFlowers_
Panto2

LoopedFlowers_
Panto3

LoopedFlowers_
Segment

LoopedFlowers_
Square

LoopedFlowers_
Triangle

LoopedFlowers_
Wreath

LooseSwirlFeathers_
Border

LooseSwirlFeathers_
Corner
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Name Quilt Design Name Quilt Design

LooseSwirlFeathers_
Panto

LooseSwirlFeathers_
Segment

LooseSwirlFeathers_
Square

LooseSwirlFeathers_
Triangle

Panto_Candle Panto_Hearts1*

*A pantograph is
created only with the
«Panto_Hearts2»
design

Panto_Hearts2*

*A pantograph is
created only with the
«Panto_Hearts1»
design

Panto_LooseSwirls

Panto_Square Meander Panto_Stars

Panto_SwirlFlower Panto_Swirls

PebblesShell_Square

Jump stitch: 1
 S 

PebblesShells_Border

PebblesShells_Corner PebblesShells_Panto

PebblesShells_
Segment

PebblesShells_Triangle
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Name Quilt Design Name Quilt Design

PebblesShells_Wreath SwirlsPaisley_Border

SwirlsPaisley_Corner SwirlsPaisley_Panto

SwirlsPaisley_Segment SwirlsPaisley_Square1

SwirlsPaisley_Square2 SwirlsPaisley_Triangle

SwirlsPaisley_Wreath Panto_TightSwirls

VinesBerries_Block VinesBerries_Border

VinesBerries_Border2 VinesBerries_Corner

VinesBerries_Panto VinesBerries_Triangle

VinesBerries_Wreath
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Keryn Emmerson

Name Quilt Design Name Quilt Design

Bellflower Bellflower2

Bramble Bramble2

Camelia Camelia2

Cherish Cherish2

China grove China grove2

China sea China sea2

Cottontop Cottontop2

Leafarama Leafarama2

Offkilter Offkilter2

Scrap paper Scrap paper2
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Name Quilt Design Name Quilt Design

Smoke Smoke2

Star&crescent Star&crescent2

Streamer Streamer2

Tangle Villette

Villette2

Patricia Ritter

Name Quilt Design Name Quilt Design

Aloha Block Petite 
Corner_PR053

Aloha Block1_PR009

Aloha Block2_PR010 Aloha Petite_
PRPANTO10

Aloha Sashings_
PRPANTO35

Aralia

Leaf Sashing1 Morning Glory

PR007 PR011
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Name Quilt Design Name Quilt Design

PR012 PR016

PR082 PR0125

PR126 PR127

PR128 PRPANTO01

PRPANTO21 PRPANTO47

PRPANTO64 PRPANTO65

PRPANTO68 PRPANTO68_gross

PRPANTO83 PRPANTO100

PRPANTO110 PRPANTO131

PRPANTO145 PRPANTO150

PRPANTO151 PRPANTO152

PRPANTO189 PRPANTO321

PRPANTO489 Rebekah's rose
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Aggy Burczyk

Name Quilt Design Name Quilt Design

Ayana_basic Ayana_block_01

Ayana_block_02 Ayana_block_03

Jump stitch: 1

Ball_01 Bellini_01

Bellini_02 Butterfly_01

Butterfly_01_E2E Butterfly_02

Butterfly_03_E2E Circles

Denebola Feathers and Pearls_01

Feathers and Pearls_02

Jump stitches: 3

Georgette_01

Georgette_02 Half Moon_Sashing_01

Half Moon_Border_02 Half Moon_Sashing_03

Jump stitches: 2
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Name Quilt Design Name Quilt Design

Half
Moon_Sashing_03_XS

Jump stitches: 3

Hexagon_fill_01

Hexagon_fill_02 Hexagon_fill_03

Hexagon_fill_04 Hexagon_fill_05

Pearls on a string Pearls on a string_heart

Pearls on a string_ring Pearls_basic

Skijumper Square_fill_01

Square_fill_02 Swirl_01

Waves_Circles_double Waves_Circles_single

Basic Shape/Frame

Name Quilt Design Name Quilt Design

Basics_01 Basics_02
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Name Quilt Design Name Quilt Design

Basics_03 Basics_04

Basics_05 Basics_06

Basics_07 Basics_08

Basics_09 Basics_10

Cake Circle

Double_Swirl_3 Heart_01

Heart_02 Hexagon

Pentagon Rectangle_ASS

Spiral_4 Spiral_6

Square Star_01

Star_02 Swirl_basic
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Name Quilt Design Name Quilt Design

Swirl_3 Triangle

Waves_basic

Alfonsina Uriburu

Name Quilt Design Name Quilt Design

Celia1 Celia3

Delia1 Delia3

Elina1 Elina2

Heart line Heart line2_1

Hock block Julia

Julia block Laura Block

Lilli Lourdes

Mejillon block Patricia
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Name Quilt Design Name Quilt Design

Petal Petal element

Linzi Upton

Name Quilt Design Name Quilt Design

QE1

Jump stitches: 7

QE5

Jump stitch: 1

QE9 QE10

QE11 QE12

QE13

Jump stitches: 1

QE18

Jump stitches: 3

QE19

Jump stitches: 4

QE23

Jump stitch: 1

Gerda Raschle

Name Quilt design Name Quilt design

Ball_Block Circle_Flower

Dog-foot Fantasy
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Name Quilt design Name Quilt design

Feet Feet_1

Fingerprint Flower_evergreen_02

Flower_evergreen_01 Hands

Mandala no

Ovale_Stone Pebbles Square

Pictures Frame Rosa

Row of houses Swiss _Flower

Yes

Lisa H. Calle

Name Quilt Design Name Quilt Design

LC 13 Swan's Journey
Block 2

LC 13V1 Swan's
Journey Block 2A

Jump stitches: 5

LC 13V2 Swan's
Journey Block 1

Jump stitches: 7

LC 14 Swan's Journey
Corner Large

Jump stitch: 1
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Name Quilt Design Name Quilt Design

LC 15 Swan's Journey
Corner Sm

Jump stitch: 1

LC 16 Swan's Journey
Frame

LCPANTO24 Swan's
Journey BDR

LCPANTO25 Swan's
Journey Panto LG

LCPANTO26 Swan's
Journey Small

LCPANTO27 Swan's
Journey Sash

Tula Pink

Name Quilt Design Name Quilt Design

TP_BandBee_1

Jump stitches: 5

TP_BandBee_2

Jump stitches: 6

TP_BandBee_Circle TP_BandBee_Flower

TP_FeatherPaisley_1

Jump stitches: 2

TP_FeatherPaisley_2

Jump stitches: 2

TP_FeatherPaisley_Origi
nal

TP_Snail_1

Jump stitches: 2

TP_Snail_2

Jump stitch: 1

TP_Snail_Original

Jump stitches: 2
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Sarah Vedeler

Name Quilt Design Name Quilt Design

SV_A

Jump stitches: 4

SV_B

Jump stitches: 3

SV_C

Jump stitch: 1

SV_D

Jump stitches: 2

SV_E

Jump stitch: 1

SV_F

Jump stitches: 2

SV_G

Jump stitches: 3

SV_H

Jump stitch: 1

SV_I

Jump stitches: 2

SV_J

Jump stitch: 1

SV_K

Jump stitches: 4

SV_L

Jump stitch: 1

SV_M

Jump stitch: 1

SV_N

Jump stitch: 1

SV_O

Jump stitches: 4

SV_P

Jump stitches: 2

SV_Q

Jump stitches: 4

SV_Q_with border

Jump stitches: 6

SV_R

Jump stitches: 4

SV_S

Jump stitches: 3

SV_T

Jump stitches: 4

SV_U

Jump stitches: 5
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Name Quilt Design Name Quilt Design

SV_V

Jump stitches: 3

SV_W

Jump stitch: 1

SV_X

Jump stitch: 1

SV_Y

Jump stitches: 4

SV_Z

Jump stitch: 1

SV_Inner border

SV_Outer border

OESD

Name Quilt Design Name Quilt Design

12380-04 12380-08

12380-09 12380-10

32196-01 32196-01-B

32196-02 32196-03

32196-04 32196-05
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Name Quilt Design Name Quilt Design

32196-06 32196-07

32196-07-B 32196-08

32196-09 32196-10

32196-10-B 32196-11

32196-12 32196-12-B

32196-13 32196-13-B

32196-14 32196-15

32196-16 32196-17

32196-18 32196-19



APPENDIX

82

Name Quilt Design Name Quilt Design

32196-21 32196-21-B

32196-22 32196-23

32196-23-B 32196-24

32196-24-B 32196-25

32196-27 32196-28

32196-29 32196-30-B

BD285 BD289-01

BD292-01 BD299-01

BD308-01 BD394



APPENDIX

83

Name Quilt Design Name Quilt Design

BD412-01 BD413-01

BD513 BD513-B

BD514 BD553-01

BD554 BD567

BD659-B BD665

BD800 BD801

BD804-01 BD837

HE959-01
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